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1.  Introduction 
 

1.1 Add-on Module RF-TIMBER AWC 

The National Design Specification for Wood Construction (ANSI/AWC NDS-2012) incorporates 
design provisions for both allowable stress design (ASD) and load and resistance factor design 
(LRFD). This specification is adopted in all model building codes in the United States and is 
used to design wood structures worldwide. With the RFEM add-on module RF-TIMBER AWC 
from the company DLUBAL all users obtain a powerful tool for the design of timber structures 
modeled with member elements according to this standard. 

RF-TIMBER AWC performs all cross-section resistance designs, stability analyses, and deforma-
tion analyses provided by the standard. The stability analysis is carried out according to the 
equivalent member method or the second-order analysis. When the equivalent member meth-
od is applied, the program considers stability factors based on effective buckling lengths and 
effective lengths for lateral buckling. Second order analysis requires definition of imperfections 
in RFEM and calculates with unit stability factors for compression with buckling. In addition to 
this, the fire resistance design for allowable stress design (ASD) is possible. 

In timber construction, the serviceability limit state represents an important design. In this 
connection, chosen load cases, load combinations, and result combinations can be checked 
for limit deflection. The conservative limit deformation is preset, but can be modified, if neces-
sary. In addition to this, it is possible to specify reference lengths and precambers that will be 
considered accordingly in the design. 

If necessary, you can optimize standardized or parametric cross-sections and export them to 
RFEM. Separate design cases allow for a separate design of large systems or analysis of vari-
ants. 

RF-TIMBER AWC is one of the add-on modules integrated in the RFEM environment. Thus, the 
design-relevant input data is preset when you open the module. Subsequent to the design, 
you can use the graphical RFEM user interface to evaluate the results. Last but not least, you 
can document the checks from the analysis of internal forces to the design in the global print-
out report. 

We hope you will enjoy working with RF-TIMBER AWC. 

Your DLUBAL Team 
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1.2 RF-TIMBER AWC - Team 
The following people were involved in the development of RF-TIMBER AWC: 

Program coordination 
Dipl.-Ing. Georg Dlubal 
Ing. Ondřej Švorc 

Dipl.-Ing. (FH) Bastian Kuhn 

Programming 
Ing. Tomáš Drtina 
Dipl.-Ing. Georg Dlubal 

Ing. Jiří Patrák 

Cross-section and material database 
Ing. Jan Rybín, Ph.D. 
Mgr. Petr Oulehle 

Ing. Jiří Kubíček 

Program design, dialog figures, icons 
Dipl.-Ing. Georg Dlubal 
MgA. Robert Kolouch 

Ing. Jan Miléř 

Program supervision 
Ing. Jiří Hanzálek 
Dipl.-Ing. (FH) Gerhard Rehm 

Ing. Ondřej Švorc 
Ing. Myroslava Petronyuk 

Localization, manual 
Ing. Fabio Borriello 
Ing. Dmitry Bystrov 
Eng.º Rafael Duarte 
Ing. Lara Caballero Freyer 
Ing. Alessandra Grosso, Ph.D. 
Ing. Ladislav Kábrt 
Ing. Aleksandra Kociołek 
Eng.º Nilton Lopes Fernandes 

Mgr. Ing. Hana Macková 
Ing. Téc. José Martínez Hernández 
Dipl.-Ü. Gundel Pietzcker 
Mgr. Jagoda Podgórna 
BSc Eng Chelsea Prokop 
Dipl.-Ing. Jing Sun 
Ing. Marcela Svitáková 
Dipl.-Ing. (FH) Robert Vogl 

Technical support and quality management 
M.Eng. Cosme Asseya 
Dipl.-Ing. (BA) Markus Baumgärtel 
Dipl.-Ing. Moritz Bertram 
M.Sc. Sonja von Bloh 
Dipl.-Ing. (FH) Steffen Clauß 
Dipl.-Ing. Frank Faulstich 
Dipl.-Ing. (FH) René Flori 
Dipl.-Ing. (FH) Stefan Frenzel 
Dipl.-Ing. (FH) Walter Fröhlich 
Dipl.-Ing. (FH) Paul Kieloch 

Dipl.-Ing. (FH) Bastian Kuhn 
Dipl.-Ing. (FH) Ulrich Lex 
Dipl.-Ing. (BA) Sandy Matula 
M.Eng. Dipl.-Ing. (BA) Andreas Niemeier 
Dipl.-Ing. (FH) Gerhard Rehm 
M.Eng. Dipl.-Ing. (FH) Walter Rustler 
M.Sc. Dipl.-Ing. (FH) Frank Sonntag 
Dipl.-Ing. (FH) Christian Stautner 
Dipl.-Ing. (FH) Lukas Sühnel 
Dipl.-Ing. (FH) Robert Vogl 
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1.3 Using the Manual 
Topics like installation, graphical user interface, results evaluation, and printout are described 
in detail in the manual of the main program RFEM. The present manual focuses on typical fea-
tures of the RF-TIMBER AWC add-on module. 

The descriptions in this manual follow the sequence and structure of the module's input and 
results windows. In the text, the described buttons are given in square brackets, for example 
[View mode]. At the same time, they are shown on the left. Expressions appearing in dialog 
boxes, windows, and menus are set in italics to clarify the explanations. 

At the end of the manual, you find the index. However, if you still cannot find what you are 
looking for, please check the DLUBAL blogs at https://www.dlubal.de/blog/en where you can 
search the articles by specific terms. 

1.4 Open the Add-on Module RF-TIMBER AWC 
RFEM provides the following options to start the add-on module RF-TIMBER AWC. 

Menu 
To start the program in the RFEM menu bar, click 

Add-on Modules → Design - Timber → RF-TIMBER AWC. 

 

Figure 1.1: Menu: Add-on Modules → Design - Timber → RF-TIMBER AWC 

https://www.dlubal.de/blog/en/


1  Introduction 

 7 Program RF-TIMBER AWC © 2014 Dlubal Software GmbH 

 

Navigator 
As an alternative, you can start the add-on module in the Data navigator by clicking 

Add-on Modules → RF-TIMBER AWC. 

 

Figure 1.2: Data navigator: Add-on Modules → RF-TIMBER AWC 

Panel 
If results from RF-TIMBER AWC are already available in the RFEM model, you can also open the 
design module in the panel: 

Set the relevant RF-TIMBER AWC design case in the load case list of the RFEM toolbar. Then 
click the [Show results] button to graphically display the design criterion on the members. 

When the results display is activated, the panel is available, too. Now you can click the button 
[RF-TIMBER AWC] in the panel to open the module. 

 

Figure 1.3: Panel button [RF-TIMBER AWC] 
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2.  Input Data 
When you have started the add-on module, a new window opens. In this window a Navigator  
is displayed on the left, managing the available windows that can be currently selected. The 
drop-down list above the navigator contains the design cases (see Chapter 7.1, page 62). 

The design relevant data is defined in several input windows. When you start RF-TIMBER AWC 
for the first time, the following parameters are imported automatically: 

• Members and sets of members 

• Load cases, load combinations, and result combinations 

• Materials 

• Cross-sections 

• Effective lengths 

• Internal forces (in background, if calculated) 

To select a window, click the corresponding entry in the navigator. To set the previous or next 
input window, use the buttons shown on the left. You can also use the function keys to select 
the next [F2] or previous [F3]. 

To save the results, click [OK]. Thus, you exit RF-TIMBER AWC and return to the main program.  
To exit the module without saving the new data, click [Cancel]. 

2.1 General Data 
In the 1.1 General Data window, you select the members, sets of members, and actions that 
you want to design. The tabs are managing the load cases, load and result combinations for 
the different designs. 

 
Figure 2.1: Window 1.1 General Data 
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Design of 

 
Figure 2.2: Design of members and sets of members 

The design can be carried out for Members as well as for Sets of Members. If you want to design 
only selected objects, clear the All check box. Then you can access the text boxes to enter the 
numbers of the relevant members or sets of members. The list of the numbers preset in the 
field can be cleared by clicking the [Delete] button. Alternatively, you can select the objects 
graphically in the RFEM work window after clicking []. 

When you design a set of members, the program determines the extreme values of the anal-
yses of all members contained in the set of members and takes into account the boundary 
conditions of connected members for the stability analysis. The results are shown in the results 
windows 2.3 Designs by Set of Members, 3.2 Governing Internal Forces by Set of Members, and  
4.2 Parts List by Set of Members. 

Click [New] to create a new set of members. The dialog box that you already know from RFEM 
appears where you can specify the parameters of set of members. 

Design according to 

 
Figure 2.3: Design according to ASD or LRFD 

The options of the list box control whether the analysis is carried out according to the pro-
visions of the Allowable Stress Design (ASD) or the Load and Resistance Factor Design (LRFD). 

Comment 

 
Figure 2.4: User-defined comment 

In this text box, you can enter user-defined notes describing, for example, the current design 
method. 
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2.1.1 Ultimate Limit State 

 
Figure 2.5: Window 1.1 General Data, tab Ultimate Limit State 

Existing Load Cases and Combinations 
This column lists all load cases, load combinations, and result combinations created in RFEM.  

To transfer selected entries to the Selected for Design list on the right, click []. Alternatively, 
you can double-click the items. To transfer the complete list to the right, click []. 

To transfer multiple entries at once, select them while pressing the [Ctrl] key, as common for 
Windows applications. 

Load cases highlighted in red, like LC 6 in Figure 2.5, cannot be designed: This happens when 
the load cases are defined without any load data or the load cases contain only imperfections. 
When you transfer the load cases, a corresponding warning appears. 

At the end of the list, several filter options are available. They will help you assign the entries 
sorted by load case, load combination, or action category. The buttons have the following 
functions: 

 
Selects all load cases in the list 

 
Inverts the selection of load cases 

Table 2.1: Buttons in the tab Ultimate Limit State 

Selected for Design 
The column on the right lists the load cases, load combinations, and result combinations se-
lected for design. To remove selected entries from the list, click [] or double-click the entries. 
To transfer the entire list to the left, click []. 

The design of an enveloping max/min result combination is performed faster than the design 
of all contained load cases and load combinations. 

However, the analysis of a result combination has also disadvantages: First, the influence of the 
contained actions is difficult to discern. Second, for the determination of the volume factor CV 
for structural glued laminated timber, the envelope of the moment distributions is analyzed. 
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From that, the most unfavorable distribution (max or min) is applied. However, this distribu-
tion only rarely reflects the moment distribution in the individual load combinations. Thus, in 
the case of RC design, more unfavorable values of the factor CV are to be expected, leading to 
higher ratios.  

Result combinations should be selected for design only for dynamic combinations. For "usual" 
combinations, load combinations are recommended. 

2.1.2 Serviceability Limit State  

 
Figure 2.6: Window 1.1 General Data, tab Serviceability Limit State 

Existing Load Cases and Combinations 
This section lists all load cases, load combinations, and result combinations created in RFEM. 

Selected for Design 
Load cases, load combinations, and result combinations can be added or removed (see Chap-
ter 2.1.1). 

The limit value of the deformation is controlled by the settings in the Details dialog box (see 
Figure 3.3, page 40) which you can call up by clicking the [Details] button. 

In the 1.10 Serviceability Data window, the reference lengths decisive for the deformation 
check are managed (see Chapter 2.11, page 33). 



2  Input Data 

 12 Program RF-TIMBER AWC © 2014 Dlubal Software GmbH 

 

 

     

   

 

2.1.3 Fire Resistance 
This tab is only available when the ASD design method has been set. 

 
Figure 2.7: Window 1.1 General Data, tab Fire Resistance 

Existing Load Cases and Combinations 
All load cases, load combinations, and result combinations created in RFEM are listed here. 

Selected for Design 
Load cases, load and result combinations can be added or removed (see Chapter 2.1.1). 

The fire resistance design is performed by means of a reduced cross-section. The general speci-
fications for the fire resistance design are managed in the dialog boxes Standard (see Figure 2.9, 
page 13) and Details, tab Fire Resistance (see Figure 3.4, page 41). 

2.1.4 Standard 
The drop-down lists in the 1.1 General Data window allow you to select the method of design 
whose parameters are to be applied to the design. 

 
Figure 2.8: Design method 

To check and, if necessary, adjust the preset parameters, click [Edit] (see the following figure). 

Alternatively you can use the [Standard] button in all input windows in order to open the 
Standard dialog box consisting of three tabs. The content of the dialog box depends on the 
selected design method. 
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General 

 
Figure 2.9: Dialog box Standard, tab General for ASD design method 

 
Figure 2.10: Dialog box Standard, tab General for LRFD design method 
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In the dialog box sections, you can check or, if necessary, modify, the Wet Service Factors and 
the Temperature Factor (prescribed for both ASD and LRFD method), the Load Duration or Time 
Effect Factor (different for ASD and LRFD method), and the Format Conversion and Resistance 
Factors (LRFD only). 

The Data for Fire Design section manages the parameters Design Stress to Member Strength Fac-
tor and Nominal charring rate βn. The fire design is applied only for the ASD design method. 

The buttons in the Standard dialog box have the following functions: 

 

 
Table 2.2: Buttons in dialog box Standard 

Others 
In the second tab of the Standard dialog box, you find several factors significant for the design. 
These factors are prescribed for both ASD and LRFD methods and can be also modified, if nec-
essary. 

 
Figure 2.11: Dialog box Standard, tab Others 

Button Function 

 Resets the program's default settings 

 
Imports user-defined standard settings 

 
Saves the current settings as default 

 
Deletes a user-defined Standard 
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Used Standards 
The third tab of the Standard Settings dialog box informs you about the Standards according to 
which the design will be performed. 

 
Figure 2.12: Dialog box Standard, tab Used Standards 
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2.2 Materials 
The window consists of two parts. In the upper part, all materials created in RFEM are listed. In 
the Material Properties section, the properties of the current material, that is, the table row cur-
rently selected in the upper section, are displayed. 

 
Figure 2.13: Window 1.2 Materials 

Materials that will not be used in the design are dimmed. Materials that are not allowed are 
highlighted in red. Modified materials are displayed in blue. 

The material properties required for the determination of internal forces are described in 
Chapter 4.3 of the RFEM manual (Main Properties). The material properties required for design 
are stored in the global material library. These values are preset (Additional Properties). 

To adjust the units and decimal places of material properties and stresses, select from the 
module's menu Settings → Units and Decimal Places (see Chapter 7.3, page 66). 

Material Description 
The materials defined in RFEM are preset, but you can always modify them: To select the field, 
click the material in column A. Then click [] or press function key [F7] to open the material list. 

 
Figure 2.14: List of materials 
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According to the design concept of ANSI/AWC NDS-2012 [1] and its Supplement [2], the list in-
cludes only materials of the U.S. standard. Visually graded decking (i.e. material according to 
[2] "Table 4E") is not included in RF-TIMBER AWC. 

When you have imported a material, the design relevant Material Properties are updated. 

If you change the material description manually and the entry is stored in the material library, 
RF-TIMBER AWC will import the material properties, too. 

It is not possible to edit the material properties in the add-on module RF-TIMBER AWC. 

Material Library 
Numerous materials are already available in the library. To open the corresponding dialog box, 
select menu 

Edit → Material Library 

or click the button shown on the left. 

 
Figure 2.15: Dialog box Material Library 

In the Filter section, ANSI/AWC is preset as Standard. Select the material quality that you want 
to use for the design in the Material to Select list. You can check the corresponding properties 
in the dialog section below. 

Click [OK] or press [↵] to transfer the selected material to Window 1.2 of RF-TIMBER AWC. 

Chapter 4.3 of the RFEM manual describes in detail how materials can be filtered, added, or 
rearranged. 
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Material Properties 
The lower section of Window 1.2 contains the reference design values for bending Fb, tension 
parallel Ft, shear Fv, compression parallel Fc, compression perpendicular Fcp, as well as modulus 
of elasticity for stability calculations Emin. 

The reference bending, shear and compression perpendicular design values and reference 
modulus of elasticity for stability calculations for structural glued laminated timber are ex-
tended for cases of bending perpendicular and parallel to wide faces of laminations and bend-
ing to Fbx and Fby. When structural laminated timber material stressed primarily in bending (i.e. 
material of "Table 5A" and "Table 5C" special application) is chosen, value Fbx is doubled for the 
case of positive Fbx

+ and negative Fbx
- bending. In addition, for such a softwood timber (i.e. ma-

terial of "Table 5A" special application), value Fcp is doubled for tension Fcpx,ten.face and compres-
sion Fcpx,comp.face face of cross-section. 

The design values of the material strengths are to be determined with the modification factors. 
Those factors can be modified in the Standard Settings dialog box (see Figure 2.9 and Figure 
2.10, page 13). 

Special Settings 
For cross-sections greater than 15 in. deep, where structural glued laminated timber stressed 
primarily in axial tension or compression (i.e. material of "Table 5B" and "Table 5D" special ap-
plication) is used, the reference bending design value Fbx can be considered to be reduced by 
multiplying by a factor of 0.88. 

If you select this option, the program reduces the mentioned bending design value automati-
cally. 

2.3 Cross-Sections 
This window manages the cross-sections used for design. You can also specify parameters for 
the optimization here. 

 
Figure 2.16: Window 1.3 Cross-Sections 



2  Input Data 

 19 Program RF-TIMBER AWC © 2014 Dlubal Software GmbH 

 

 
 

 

 

 

Axis System 
In RF-TIMBER AWC, the cross-sectional axis system is applied according to [1]. That system is 
different to the one used in RFEM: The module’s axis x corresponds to axis y of RFEM, and axis 
y to axis z accordingly. Sometimes the axis’ symbols y/x and z/y are used in RF-TIMBER AWC. 

 
Figure 2.17: Axis systems used in RFEM and RF-TIMBER AWC 

Cross-Section Description 
The cross-sections defined in RFEM are preset together with the assigned material numbers.  

The design is possible for the parametric timber rectangular and circular cross-section and for 
standardized timber rectangular cross-section according to ANSI/AWC NDS-2012 [1]. 

The table Cross-Section Properties below displays the size factors CF and flat use factors Cfu of 
each cross-section. For standardized timber cross-sections (see Figure 2.19), you can define the 
values automatically or manually by using the [] button. 

To modify a cross-section, click the entry in column B selecting this field. Click [Cross-section 
Library] or [...] in the field or press function key [F7] to open the cross-section table of the cur-
rent input field (see the following two figures). 

In this dialog boxes, you can select a different cross-section or a different cross-section table. 
To select a different cross-section category, click [Back to cross-section library] to access the 
general cross-section library. 

Chapter 4.13 of the RFEM manual describes how cross-sections can be selected from the li-
brary. 
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Figure 2.18: Parametric timber cross-sections of the cross-section library 

 
Figure 2.19: Standardized timber cross-sections of the cross-section library 

The new cross-section description can be entered in the text box directly. If the data base con-
tains an entry, RF-TIMBER AWC imports these cross-section parameters, too. 

A modified cross-section will be highlighted in blue. 

If cross-sections specified in RF-TIMBER AWC are different from the ones used in RFEM, both 
cross-sections are displayed in the graphic on the right. The designs will be performed with the 
internal forces of RFEM for the cross-section selected in RF-TIMBER AWC. 
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Max. Design Ratio 
This table column is displayed only after the calculation. It is a decision support for the optimi-
zation. By means of the displayed design ratio and colored relation scales, you can see which 
cross-sections are little utilized and thus oversized, or overloaded and thus undersized. 

Optimize 
You can optimize all rectangular and circular cross-sections: For the RFEM internal forces, the 
program searches the cross-section that comes as close as possible to a user-defined maximum 
utilization ratio. You can define the maximum ratio in the Other tab of the Details dialog box, 
(see Figure 3.5, page 42). 

If you want to optimize a cross-section, open the drop-down list in column D or E. Recommen-
dations for optimizing cross-sections can be found in Chapter 7.2 on page 63. 

Remark 
This column shows remarks in the form of footers that are described in detail below the cross-
section list. 

A warning might appear before the calculation: Cross-section does not have a valid material! 
This means that this cross-section is not allowed to be used in combination with the defined 
material. In RF-TIMBER AWC, it is not possible to use rectangular cross-sections with structural 
round timber poles and piles material (i.e. material of [2] Table 6A and Table 6B), and circular 
cross-sections with dimensional lumber or structural glued laminated timber (i.e. material of 
[2] Table 4A, Table 4B, Table 4C, Table 4D, Table 4F, Table 5A, Table 5B, Table 5C and Table 5D). 

Info About Cross-Section 
In the Info About Cross-Section dialog box, you can check the cross-section properties and 
stress points. 

 
Figure 2.20: Dialog box Info About Cross-Section 

The right part of the dialog box shows the currently selected cross-section. 
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The buttons below the graphic have the following functions: 

 

 

Table 2.3: Buttons of cross-section graphic 

Click [Details] to call up specific information on the stress points (distances to center of gravity, 
statical moments, etc.). 

 
Figure 2.21: Dialog box Stress Points 

Member with tapered cross-section 
For tapered members with different cross-sections at both member ends, the module displays 
the two cross-sections numbers in separate table rows, in accordance with the definition in 
RFEM. 

RF-TIMBER AWC is also able to design tapered members if the same cross-section type is de-
fined for the start and the end cross-section. Additional specifications are required in Window 
1.14 (see Chapter 2.14, page 36). 

Button Function 

 
Displays or hides the stress points 

 
Displays or hides the numbers of stress points 

 
Shows the details of the stress points (see Figure 2.21) 

 
Displays or hides the dimensions of the cross-section 

 
Displays or hides the principal axes of the cross-section 

 
Resets the full view of the cross-section graphic 

 
Prints the cross-section values and cross-section graphic 
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2.4 Load Duration 
In Window 1.4, you define the load duration to consider factors reflecting the different load du-
ration for all chosen load cases, load and result combinations as well as dynamic combinations. 

 
Figure 2.22: Window 1.4 Load Duration  

Loading 
All actions selected in the 1.1 General Data window are listed here. For combinations, included 
load cases are listed, too. 

Description 
The load case descriptions make the classification easier. 

Load Type 
This table column shows the load cases' types of action as defined while creating them in RFEM. 
They are the basis for the presetting in the subsequent table column. 

Load Duration 
Loads and their superpositions must be assigned to the load duration for the design. The clas-
sification of actions is specified for example in [1] Table 2.3.2. 

For load cases and variable result combinations, the load duration can be changed by using 
the list shown on the left: Click the cell in column C, thus selecting the field. The [] button be-
comes available. For load combinations and Or result combinations, RF-TIMBER AWC performs 
the classification automatically taking into account the shortest load duration action of includ-
ed load cases. When the bottom-side button is switched to User-defined settings, load combi-
nations and Or result combinations are user-changeable as well.  

The class of the load duration is required for the determination of the load duration factor CD in 
the ASD method and time effect factor λ in the LRFD method.  
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Factor CD / λ 
The impact of the load duration on the strength properties is taken into account by means of 
the load duration factor CD (ASD) or the time effect factor λ (LRFD) (see [1] Table 2.3.2 and N3). 

The factors can be checked and, if necessary, adjusted in the Standard Settings dialog box (see 
Figure 2.9 and Figure 2.10, page 13). 

Loading Condition (Radial Stress Design) 
In the table, column E is activated only when at least one tapered or curved member is select-
ed for the design. In this case, the loading conditions must be assigned so that the radial ten-
sion stress, Frt, can be determined (see [1] Table 5.2.8). 

2.5 In-Service Conditions - Members 
The determination of moisture and temperature service conditions makes it possible to assign 
the temperature factors CT and wet service factors CM to each member. The moisture service 
conditions can be specified individually for each material according to [2][1], the temperature 
conditions according to [1] Table 2.3.3. 

 
Figure 2.23: Window 1.5 In-Service Conditions - Members 

By default, the program assigns dry service conditions and temperatures below 100 °F. If you 
want to allocate different moisture or temperature conditions to specific members, use the [] 
button to open the lists. 

Below the Settings table, you find the Set inputs for members No. check box. If it is selected, the 
settings entered afterward will be applied to the selected or to All members. Members can be 
selected by entering their numbers or by selecting them graphically using the [] button. That 
option is useful when you want to assign identical conditions to several members. Please note 
that settings that have been already defined cannot be changed subsequently by this function.
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The other buttons below the table have the following functions: 

Button Function 

 Export of table to MS Excel or OpenOffice.org Calc 

 
Option to select member graphically in RFEM window and set its row in table 

 View mode for switching to RFEM work window 

Table 2.4: Buttons in Window 1.5 In-Service Conditions - Members 

2.6 In-Service Conditions - Set of Members 
This window is only available if one or more sets of members have been selected in Window 
1.1 General Data. 

 
Figure 2.24: Window 1.6 In-Service Conditions - Sets of Members 

The set-up of this window is similar to the one of the previous Window 1.5 In-Service Conditions 

- Members. Here you can assign temperature and moisture service conditions to each set of 
members. 
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2.7 Effective Lengths - Members 
The appearance of the window depends on whether the stability analysis is carried out accord-
ing to the equivalent member method or according to second-order analysis. You can specify 
that method in the Stability tab of the Details dialog box (see Figure 3.2, page 39). The follow-
ing description refers to the equivalent member default method. For that, the parameters of 
buckling and lateral-torsional buckling must be defined. 

If the stability analysis is deactivated in the Stability tab of the Details dialog box, Window 1.7 is 
not shown. 

The window consists of two parts. The table in the upper part lists the factors for the lengths of 
buckling and lateral-torsional buckling as well as the equivalent member lengths of the mem-
bers selected for design. The effective lengths defined in RFEM are preset. In the Settings sec-
tion, you can see further information on the member whose row is selected in the upper table. 

Click [] to select a member graphically and to show its row. 

 
Figure 2.25: Window 1.7 Effective Lengths - Members for equivalent member method 

The effective lengths can be entered manually in the table and in the Settings tree, or defined 
graphically in the work window after clicking [...]. This button is available as soon as you have 
clicked in the text box (see Figure above). 

The Settings tree manages the following parameters: 

• Cross-Section 

• Member Length 

• Buckling Possible (corresponds to column A) 

• Buckling About Axis x Possible (corresponds to columns B to D) 

• Buckling About Axis y Possible (corresponds to columns E to G) 

• Lateral-Torsional Buckling Possible (corresponds to columns H to J) 

In this table, you can specify for the currently selected member whether to carry out a buckling 
or a lateral-torsional buckling analysis. In addition to this, you can adjust the Effective Length 
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Coefficient for the respective directions. When a coefficient is modified, the equivalent member 
length is adjusted automatically, and vice versa. 

You can also define the buckling length of a member in a dialog box. To open it, click the 
button shown on the left. It is located on the right below the upper table of the window. 

 
Figure 2.26: Dialog box Select Effective Length Factor 

For each direction, you can select one of the buckling modes (theoretical and recommended 
values of buckling length factors according to [1] Table G1) or enter a User-defined effective 
length coefficient Ky. 

If an eigenvalue analysis was carried out in the add-on module RF-STABILITY, you can also se-
lect a Buckling Mode to determine the factor. 

Buckling Possible 
The stability analysis for flexural buckling and lateral-torsional buckling requires the ability of 
members to resist compressive forces. Therefore, members for which such resistance is not 
possible because of the member type (for example tension members, elastic foundations, rigid 
couplings) are excluded from design in the first place. The corresponding rows appear dimmed 
and a note is displayed in the Comment column. 

The Buckling Possible check boxes in table column A and in the Settings tree enable you to clas-
sify members as compression members or to exclude them from the stability analysis. 
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Buckling About Axis x / Buckling About Axis y 
With the check boxes in the Possible table columns, you decide whether a member is suscepti-
ble to buckling about the x-axis and/or y-axis (see Chapter 2.3, page 19 for the axis systems). 
Those axes represent the local member axes, with the x-axis as the "major" and the y-axis the 
"minor" member axis. The buckling length coefficients Ke,x and Ke,y for buckling about the major 
or the minor axis can be selected freely.  

You can check the position of the member axes in the cross-section graphic in Window 1.3 
Cross-Sections (see Figure 2.16, page 18).  

To access the RFEM work window, click the [View Mode] button. In the work window, you can 
display the local member axes by using the member's context menu or the Display navigator. 

 
Figure 2.27: Selecting the member axis systems in the Display navigator of RFEM 

If buckling is possible about one or even both member axes, you can enter the buckling length 
coefficients as well as the buckling lengths in the columns C and D respectively F and G. The 
same is possible in the Settings tree. 

To specify the buckling lengths in the work window graphically, click [...]. This button becomes 
available when you click in a le text box (see Figure 2.25). 

When you specify the buckling length coefficient Ke, the program determines the effective 
length le by multiplying the member length L by that buckling length coefficient. The text 
boxes for Ke and le are interactive.  

Lateral-Torsional Buckling Possible 
Table column H controls for which members a lateral-torsional buckling analysis is to be car-
ried out. 

Define le 

The member lengths are preset in column I as equivalent member lengths relevant for lateral-
torsional buckling. When you activate the check box in column I, you can specify the length for 
lateral-torsional buckling  le in column J. You can also define it graphically after clicking […] as 
the distance of the lateral supports. Thus, you can adjust the boundary conditions of a structur-
al component if it consists of several members between the supports. 

When the option acc. to Table 3.3.3 is selected, you can determine the lateral-torsional buckling 
length in accordance with [1] Table 3.3.3. A new dialog box is opened in which you can select 
the relevant loading conditions (see figure below). 
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Figure 2.28: Dialog box Effective Length for Bending Members  acc. to Table 3.3.3 

Below the Settings table, you find the Set inputs for members No. check box. If it is selected, the 
settings entered afterward will be applied to the selected or to All members. Members can be 
selected by entering their numbers or by selecting them graphically using the [] button. That 
option is useful when you want to assign identical conditions to several members. Please note 
that settings that have been already defined cannot be changed subsequently by this function. 

Comment 
In the last table column, you can enter your own comments for each member to describe, for 
example, the defined equivalent member lengths. 

Please note that curved members are excluded from the stability analysis. The Design Specifi-
cation [1] provides no rules how to design members of that kind of geometry.  
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2.8 Effective Lengths - Sets of Members 
This window is only available if one or more sets of members have been selected in Window  
1.1 General Data. Additionally, the stability check must have been activated in the dialog box 
Details, tab Stability (see Figure 3.2, page 39). 

 
Figure 2.29: Window 1.8 Effective Lengths - Sets of Members 

The set-up of this window is similar to the one of the previous Window 1.7 Effective Lengths - 
Members. Here you can enter the effective lengths for buckling as well as for lateral-torsional 
buckling about the two principal axes of the set of members as described in Chapter 2.7. They 
determine the boundary conditions of the entire set of members which is to be treated as an 
equivalent member. 

Please note that curved sets of members are excluded from the stability analysis. 
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2.9 Additional Design Parameters 
This window allows you to assign the adjustment factors which depend on the material of 
each member. The factors can be modified by clicking the [] button in column B. 

 
Figure 2.30: Window 1.9 Additional Design Parameters 

For sawn lumber members, you can determine whether the Repetitive Factor Cr and the Incising 
Factor Ci are to be applied in the calculation or not. 

When a structural glued laminated timber member is used, you can specify the type of edge 
joint bonding and decide whether the Shear Reduction Factor Cvr is to be used.  

For round timber poles and piles, it is necessary to specify the treatment condition (air-drying, 
kiln-drying, steam-conditioning, or boultonizing) and the load sharing condition (single pile or 
pile in group) so that the appropriate Condition Treatment Factor Cct and Load Sharing Factor Cls 
are applied. 

The members can be filtered by Material Category via the list box below the table. 

The other buttons have the following functions: 

Button Function 

 
Export of table to MS Excel or OpenOffice.org Calc 

 
Option to select member graphically in RFEM window and set its row in table 

 
View mode for switching to RFEM work window 

Table 2.5: Buttons in Window 1.9 Additional Design Parameters 

If the Set inputs for members No. check box has been activated, the settings entered afterward 
will be applied to the selected or to All members. Members can be selected by entering their 
numbers or by selecting them graphically using the [] button. That option is useful when you 
want to assign identical conditions to several members. 
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2.10 Curved Members 
This window is available when you have selected at least one member with a curved shape in 
Window 1.1 General Data for the design. Curved members can be defined, for example, by us-
ing the line types "spline" or "arc". 

The design of curved members is possible only for rectangular cross-sections and materials ac-
cording to [2] Table 5A, Table 5B, Table 5C and Table 5D (i.e. structural glued laminated timber). 

 
Figure 2.31: Window 1.10 Curved Members 

Laminate 
In this column, you have to specify the thickness t of the lamellas. 

Minimum Radius of Curvature (Inside Face) 
The program checks the ratio of the thicknesses of the lamellas and the minimal radius of cur-
vature (inside face of member). According to [1] 5.3.8, the design is allowed only for ratios not 
exceeding 1/100 (hardwoods and Southern Pine) or 1/125 (other softwoods). 

Radial Stress Design 
Optionally RF-TIMBER AWC performs a check of the radial stresses. Where the bending moment 
is in the direction tending to increase the radius, the radial stress shall not exceed the adjusted 
radial tension design value, unless mechanical reinforcing sufficient to resist all radial stress is 
used. Where the bending moment is in the direction tending to decrease the radius, the radial 
stress shall not exceed the adjusted radial compression design value. 
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2.11 Serviceability Data 
This input window controls several settings for the serviceability limit state design. It is only 
available if you have set the relevant entries in the Serviceability Limit State tab of Window 1.1 
General Data (see Chapter 2.1.2, page 11). 

 
Figure 2.32: Window 1.11 Serviceability Data 

In column A, you decide whether you want to apply the deformation to single members, lists 
of members, or sets of members. 

In table column B, you enter the numbers of the members or sets of members that you want to 
design. You can also click [...] to select them graphically in the RFEM work window. Then, the 
Reference Length appears in column D automatically. This column presets the lengths of the 
members, sets of members, or member lists. If required, you can adjust these values after se-
lecting the Manually check box in column C. 

Column E controls the governing Direction for the deformation analysis. You can select the di-
rections of the local member axes x and y (see Chapter 2.3, page 19 for the axis systems) and 
the resultant direction R. 

In columns F and G, you can allow for some Precamber wc,x and wc,y. 

The Beam Type is important to correctly determine the limit deformations. Column H controls 
whether there is a beam or a cantilever and which end is not supported. 

The settings in the Serviceability tab of the Details dialog box control whether the deformations 
are related to the undeformed initial model or to the shifted ends of members or sets of mem-
bers (see Figure 3.3, page 40). 
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2.12 Fire Resistance - Members 
This window manages the different fire resistance parameters. It is only available if you have 
set relevant entries in the Fire Resistance tab of Window 1.1 General Data (see Chapter 2.1.3, 
page 12). 

 
Figure 2.33: Window 1.12 Fire Resistance - Members 

Table column A contains the members that are to be taken into account for the fire resistance 
design. Click [...] to graphically select the members in the RFEM work window. 

In column B you specify if there is an Exposure to Fire on Four Sides. If the cross-section is not ex-
posed to fire on all sides, clear the selection of the check box. Thus, the following columns be-
come available in which you can specify the sides that are exposed to fire. The ideal remaining 
cross-section is then computed with those assumptions. 

The general parameters of the fire resistance analysis are managed in the Details dialog box, 
tab Fire Resistance Design (see Figure 3.4, page 41). 
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2.13 Fire Resistance - Sets of Members 
This window manages the fire resistance parameters of sets of members. It is displayed when 
you have selected one or more sets of members in Window 1.1 General Data and have allocat-
ed specific load cases or combinations in the Fire Resistance tab of that window. 

 
Figure 2.34: Window 1.13 Fire Resistance - Sets of Members 

The set-up of this window is similar to the one of the previous Window 1.12 Fire Resistance - 
Members. Here you can define the sides of the cross-section that are exposed to fire for the rel-
evant set of members (see Chapter 2.12). 
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2.14 Tapered Members 
This window is only available when you have selected at least one member with different 
cross-sections on both member ends for the design in Window 1.1 General Data. This window 
manages criteria such as the angle of taper of variable cross-sections, for example. 

The design of curved members with variable cross-sections is possible only for rectangular 
sections and materials according to [2] Table 5A, Table 5B, Table 5C and Table 5D. 

 
Figure 2.35: Window 1.14 Tapered Members 

Cross-Section 
The first two columns list the sections that are defined at the Member Start and Member End. 

Length L 
In this column, you can check the length of each tapered member. 

Angle of Taper θ 
RF-TIMBER AWC determines the inclination of the taper on the basis of geometric conditions. 
This angle is displayed for your information. 

Grain Parallel to Edge 
In column E, you specify the side of the member to which the direction of the grain is parallel. 
The "top" and "bottom" edges are clearly determined by the orientation of the local member 
axes z and y (see Figure 2.27, page 28). 

In most cases, the grain runs parallel to the edge that is located in the direction of the positive 
axis +z/+y ("bottom"). This means that the beam is cut at its top side (see figure below). 
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Figure 2.36: Grain parallel to edge in direction +z/+y 

If the grain is parallel to the negative axis -z/-y ("top"), then the tapered member is cut at the 
bottom side. This case is an exception because taper cuts on the tension face of beams are not 
recommended according to [1] Chapter 5.3.9. 

 
Figure 2.37: Grain parallel to edge in direction -z/-y 
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3.  Calculation 
 

3.1 Detail Settings 
Before you start the calculation, you should check the design details. You can open the corre-
sponding dialog box in all windows of the add-on module by clicking [Details]. 

The Details dialog box contains the following tabs: 

• Resistance 

• Stability 

• Serviceability  

• Fire Resistance (ASD only) 

• Other 

3.1.1 Resistance 

 
Figure 3.1: Dialog box Details, tab Resistance 

Consideration of Connections 
Often zones near member connections imply some weakening of the cross-section. It is possi-
ble to take into account this effect by a Reduction of limit tension stresses. 

The numbers of the relevant nodes can be entered manually or selected graphically by clicking 
the [] button. 
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The Connection length defines the zone on the member where reduced stresses are considered. 
In the text box below, enter the allowable stress ratio for Inside connections in percent. If neces-
sary, you can define the maximum design ratio for Outside connections of the connection zone. 

Positive or Negative Bending About y/x-Axis 
Structural glued laminated timber members stressed in bending about the y/x-axis have dif-
ferent reference bending design values for positive bending (bottom of beam stressed in ten-
sion) and negative bending (top of beam stressed in tension), see [2] Table 5A and Table 5C.  

For RF-TIMBER AWC to apply the correct bending design value, you have to specify where the 
bottom side of members is located in the positive direction of the local z/y-axis or opposite. 

Limit Value for Special Cases 
Torsion design is not specified in ANSI/AWC NDS-2012. It is possible to ignore shear stresses 
due to torsion if a user-defined ratio of the torsional shear resistance is not exceeded (default: 
5 %). If the limit is exceeded, a note appears in the result window. This limit setting is not part 
of the Design Specification [1]. Changing the limit is the responsibility of the user. 

It is also possible to completely Ignore torsion. 

3.1.2 Stability 

 
Figure 3.2: Dialog box Details, tab Stability 

Stability Analysis 
The Check Stability check box controls whether to run, in addition the cross-section design, a 
stability analysis. If you clear the check box, the input windows 1.7 and 1.8 will not be shown. 
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Equivalent member method: 
Setting method of analysis in RFEM 

The equivalent member method uses the internal forces determined in RFEM. In this method, 
make sure that the Geometrically linear static analysis has been set (the default setting for 
load combinations is the 2nd order analysis). When you perform the stability analysis according 
to the equivalent member method, the effective lengths of the members and sets of members 
subject to compression or compression and bending must be specified in windows 1.7 and 1.8. 

If the bearing capacity of the model is significantly affected by its deformations, we recom-
mend selecting a calculation according to the second order theory. This approach additionally 
requires the definition of imperfections in RFEM and their consideration for the load combina-
tions. The flexural buckling analysis is carried out during the calculation of the load combina-
tions in RFEM. 

The lateral-torsional buckling design must also be carried out for second order calculations. 
Thus, the lateral-torsional buckling lengths of members or sets of members must be specified 
in windows 1.7 and 1.8 Effective Lengths manually. This provision ensures that the lateral-tor-
sional buckling analysis is performed with the appropriate factors (for example 1.0). 

3.1.3 Serviceability  

 
Figure 3.3: Dialog box Details, tab Serviceability 

In this tab, it is possible to change the allowable deflection for the serviceability limit state 
design if the default value L/360 is not appropriate. 

With the options, you can decide whether the deformations is to be related to the Shifted ends 
of members or sets of members (i.e. connection line between start and end nodes of the de-
formed system) or to the initial Undeformed system. As a rule, the deformations have to be 
checked relative to the displacements in the entire structural system. 
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3.1.4 Fire Resistance 
This tab manages the detailed settings for the fire resistance design (ASD only). 

 
Figure 3.4: Dialog box Details, tab Fire Resistance 

The Exposure time can be selected directly or defined individually by specifying the duration  
of the fire. 

Additionally, some standard-specific parameters significant for the fire resistance design can 
be set in the Standard dialog box (see Figure 2.9, page 13). 
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3.1.5 Other 

 
Figure 3.5: Dialog box Details, tab Other 

Cross-Section Optimization 
The optimization is targeted at the maximum design ratio of 1.00. If necessary, you can specify 
a different limit value in this text box. 

Check of Member Slendernesses 
In the two text boxes, you can specify the limit values of the member slenderness. You can de-
fine the rations separately for members with bending, RB, and for members with compression, 
lei/di. 

The limit values are compared to the real member slendernesses in Window 3.3. This window 
is available after the calculation (see Chapter 4.8, page 51) when the corresponding check box 
is selected in the Display Result Windows section of this dialog box. 

Display Result Windows 
In this dialog section, you can select the results windows including parts lists that you want to 
display. The windows are described in Chapter 4 Results. 

The 3.3 Member Slendernesses window is deactivated by default. 
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3.2 Start Calculation 
To start the calculation, click the [Calculation] button which is available in all input windows of 
the RF-TIMBER AWC add-on module. 

RF-TIMBER AWC searches for the results of the load cases, load combinations, and result com-
binations to be designed. If these cannot be found, the program starts the RFEM calculation to 
determine the design relevant internal forces. 

You can also start the calculation in the user interface of RFEM: In the dialog box To Calculate 
(menu Calculate → To Calculate), design cases of the add-on modules are listed like load cases 
and load combinations. 

 
Figure 3.6: Dialog box To Calculate 

If the RF-TIMBER AWC cases are missing in the Not Calculated section, select All or Add-on Mod-
ules in the drop-down list below the section. 

To transfer the selected RF-TIMBER AWC cases to the list on the right, use the [] button. Click 
[OK] to start the calculation. 

To calculate a design case directly, use the list in the toolbar. Select the RF-TIMBER AWC case in 
the toolbar list, and then click [Show Results]. 

 
Figure 3.7: Direct calculation of a RF-TIMBER AWC design case in RFEM 

Subsequently, you can observe the design process in a separate dialog box. 



4  Results 

 44 Program RF-TIMBER AWC © 2014 Dlubal Software GmbH 

 

    

4.  Results 
The 2.1 Design by Load Case window is displayed immediately after the calculation. 

 
Figure 4.1: Results window with designs and intermediate values 

The designs are shown in the results windows 2.1 through 2.5, sorted by different criteria. 

Windows 3.1 and 3.2 list the governing internal forces. Window 3.3 informs you about the 
member slendernesses. The last two results windows 4.1 and 4.2 show the parts lists sorted  
by member and set of members. 

Every window can be selected by clicking the corresponding entry in the navigator. To set the 
previous or next input window, use the buttons shown on the left. You can also use the func-
tion keys to select the next [F2] or previous [F3] window. 

To save the results, click [OK]. You exit RF-TIMBER AWC and return to the main program. 

Chapter 4 Results describes the different results windows one by one. Evaluating and checking 
results is described in Chapter 5 Evaluation of Results starting on page 54. 

As there are different axis systems in RFEM and RF-TIMBER AWC (see Chapter 2.3, page 18), 
there are also different names of the internal forces, deformations and cross-section values. 

 
Figure 4.2: Comparison between RFEM and RF-TIMBER AWC internal forces, deformations and cross-section values 
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4.1 Design by Load Case 
The upper part of the window provides a summary, sorted by load cases, load combinations, 
and result combinations of the governing designs. Furthermore, the list is divided in Ultimate 
Limit State Design, Serviceability Limit State Design and Fire Resistance Design results. 

The lower part gives detailed information on the cross-section properties, analyzed internal 
forces, and design parameters for the load case selected above. 

 
Figure 4.3: Window 2.1 Design by Load Case 

Description 
This column shows the descriptions of the load cases, load and result combinations used for 
the designs. 

Member No. 
This column shows the number of the member that bears the maximum design ratio of every 
designed loading. 

Location x 
The column shows the x-location at which the maximum design ratio of each member occurs. 
For the table output, the program uses the following member x-locations: 

• Start and end node 

• Division points according to possibly defined member division (see RFEM table 1.16) 

• Member division according to specification for member results (RFEM dialog box  
Calculation parameters, tab Global Calculation Parameters) 

• Extreme values of internal forces 

Design 
Columns D and E show the design conditions according to ANSI/AWC NDS-2012 [1]. 

The lengths of the colored scales represent the respective utilizations. 
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Design According to Formula 
This column lists the equations of the Design Specification by which the designs have been 
performed. 

Load Duration  
In table column G, the load duration classes defined in Window 1.4 are listed (see Chapter 2.4, 
page 23). 

4.2 Design by Cross-Section 

 
Figure 4.4: Window 2.2 Design by Cross-Section 

This window lists the maximum ratios of all members and actions selected for design, sorted 
by cross-sections. The results are issued by cross-section design, stability analysis, serviceability 
limit state designs, and fire resistance design. 

For tapered members, both cross-section descriptions are displayed in the table row next to 
the cross-section number. 
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4.3 Design by Set of Members 

 
Figure 4.5: Window 2.3 Design by Set of Members 

This results window is displayed if you have selected at least one set of members for the design. 
The window lists the maximum utilization ratios sorted by set of members. 

The Member No. column shows the number of the one member within the set of members that 
bears the maximum ratio for the individual design criteria. 

The output by sets of members clearly presents the design for an entire structural group (for 
example a chord). 
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4.4 Design by Member 

 
Figure 4.6: Window 2.4 Design by Member 

This results window presents the maximum ratios for the individual designs sorted by member 
number. The columns are described in detail in Chapter 4.1 on page 45. 

4.5 Design by x-Location 

 
Figure 4.7: Window 2.5 Design by x-Location 
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This results window lists the maxima for each member at all x-locations resulting from the 
division points in RFEM: 

• Start and end node 

• Division points according to possibly defined member division (see RFEM table 1.16) 

• Member division according to specification for member results (RFEM dialog box  
Calculation Parameters, tab Global Calculation Parameters)  

• Extreme values of internal forces 

4.6 Governing Internal Forces by Member 

 
Figure 4.8: Window 3.1 Governing Internal Forces by Member 

For each member, this window displays the governing internal forces, that is, those internal 
forces that result in the maximum utilization in each design. 

Location x 
At this x-location of the member, the respective maximum design ratio occurs. 

Load Case 
This column displays the number of the load case, the load combination, or result combination 
whose internal forces result in the maximum design ratios. 

Forces / Moments 
For each member, this column displays the axial and shear forces as well as the torsional and 
bending moments producing maximum ratios in the respective cross-section designs, stability 
analyses, serviceability limit state designs, and fire resistance designs. 

Design According to Formula 
The final column provides information on the type of design and the equations by which the 
designs according to [1] have been performed. 
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4.7 Governing Internal Forces by Set of Members 

 
Figure 4.9: Window 3.2 Governing Internal Forces by Set of Members 

This window contains the individual internal forces that result in the maximum ratios of the 
design for each set of members. 
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4.8 Member Slendernesses 

 
Figure 4.10: Window 3.3 Member Slendernesses 

This results window is shown only when you have selected the respective check box in the 
Other tab of the Details dialog box (see Figure 3.5, page 42). 

The table lists the effective slendernesses of the designed members which can lose their sta-
bility as compression members, bending members or combinations of both. They were deter-
mined depending on the type of load and occurrence of buckling or lateral-torsional buckling. 
At the end of the list, you find a comparison with the limit values that have been defined in the 
Details dialog box, tab Other (see Figure 3.5, page 42). 

This window is displayed only for information. No design of the slendernesses is carried out. 
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4.9 Parts List by Member 
Finally, RF-TIMBER AWC provides a summary of all cross-sections that are included in the de-
sign case. 

 
Figure 4.11: Window 4.1 Parts List by Member 

By default, the list contains only the designed members. If you need a parts list of all members 
of the model, select the corresponding option in the Details dialog box, tab Other (see Figure 
3.5, page 42). 

Part No. 
The program automatically assigns item numbers to similar members. 

Cross-Section Description 
This column lists the cross-section numbers and descriptions. 

Number of Members 
This column shows how many similar members are used for each part. 

Length 
This column displays the respective length of an individual member. 

Total Length 
This column shows the product determined from the two previous columns. 

Surface Area 
For each part, the program indicates the surface area relative to the total length. The surface 
area is determined from the Surface Area of the cross-sections that can be seen in Windows 1.3 
and 2.1 to 2.5 (see Figure 2.20, page 21). 
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Volume 
The volume of a part is determined from the cross-sectional area and the total length. 

Unit Weight 
The Unit Weight of the cross-section is relative to the length of one meter.  

Weight 
The values of this column are determined from the respective product of the entries in column 
C and G. 

Total Weight 
The final column indicates the total weight of each part. 

Sum 
At the bottom of the list, you find a sum of the values in the columns B, D, E, F, and I. The last 
cell of the column Total Weight gives information about the total amount of timber required. 

4.10 Parts List by Set of Members  

 
Figure 4.12: Window 4.2 Parts List by Set of Members 

The last results window is displayed if you have selected at least one set of members for de-
sign. It summarizes an entire structural group (for example a chord) in a parts list. 

Details on the various columns can be found in the previous chapter. If there are different 
cross-sections in the set of members, the program averages the surface area, the volume, and 
the cross-section weight. 
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5.  Evaluation of Results 
You can evaluate the design results in different ways. For this, the buttons located below the 
upper results tables are very useful. 

 
Figure 5.1: Buttons for evaluation of results  

The buttons have the following functions: 

Button Description Function 

 ULS Design 
Shows or hides the results of the ultimate limit state 
design 

 SLS Design 
Shows or hides the results of the serviceability limit 
state design 

 Fire Resistance Design 
Shows or hides the results of the fire resistance 
design 

 Show Color Bars 
Shows or hides the colored relation scales in the 
results windows 

 

 

Filter Options 
Displays only rows with ratios greater than the filter 
criterion set in list box: design ratios > 1, maximum, 
or user-defined limit 

 Result Diagrams 
Opens the window Result Diagram on Member 
 Chapter 5.2, page 57 

 Excel Export 
Exports the table to MS Excel / OpenOffice 
 Chapter 7.4.3, page 67 

 Member Selection 
Allows you to graphically select a member to  
display its results in the table 

 View Mode Jumps to the RFEM work window to change the view 

Table 5.1: Buttons in results windows 2.1 through 2.5 
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5.1 Results in the RFEM Model 
To evaluate the design results, you can also use the RFEM work window. 

RFEM background graphic and view mode 
The RFEM work window in the background is useful for finding the position of a particular 
member in the model: The member selected in the RF-TIMBER AWC results window is high-
lighted in the selection color in the background graphic. Furthermore, an arrow indicates the 
member's x-location that is displayed in the selected window row. 

 
Figure 5.2: Indication of the member and the current Location x in the RFEM model 

If you cannot improve the display by moving the RF-TIMBER AWC module window, click [Jump 
to Graphic] to activate the View Mode: Thus, you hide the module window so that you can mod-
ify the display in the RFEM user interface. In the view mode, you can use the functions of the 
View menu, for example zooming, moving, or rotating the display. The pointer remains visible. 

Click [Back] to return to the add-on module RF-TIMBER AWC. 

RFEM work window 
You can also graphically check the design ratios in the RFEM model: Click [Graphics] to exit the 
design module. In the RFEM work window, the design ratios are now displayed like the internal 
forces of a load case. 

To turn the display of design results on or off, use the [Show Results] button known from the 
display of internal forces in RFEM. To display the result values, click the [Show Values] toolbar 
button to the right. 

The RFEM tables are of no relevance for the evaluation of design results. 

The design cases can be set by means of the list in the RFEM menu bar. 
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The graphical representation of the results can be set in the Display navigator by clicking  
Results → Members. The ratios are shown Two-Colored by default. 

 

Figure 5.3: Display navigator: Results → Members 

When you select a multicolor representation (options With/Without Diagram or Cross-Sections), 
the color panel becomes available. It provides common control functions that are described in 
detail in the RFEM manual, Chapter 3.4.6. 

 

Figure 5.4: Design ratios with display option Without Diagram 

The graphics of the design results can be transferred to the printout report (see Chapter 6.2, 
page 60). 

To return to the add-on module, click the [RF-TIMBER AWC] panel button. 
 



5  Evaluation of Results 

 57 Program RF-TIMBER AWC © 2014 Dlubal Software GmbH 

 

 

 
 

 

5.2 Result Diagrams 
You can also graphically evaluate the member results in the result diagram. 

To do this, select the member (or set of members) in the RF-TIMBER AWC results window by 
clicking in the table row of the member. Then open the Result Diagram on Member dialog box 
by clicking the button shown on the left. The button is located below the upper results table 
(see Figure 5.1, page 54). 

To display the result diagrams, select the command from the RFEM menu 

Results → Result Diagrams for Selected Members 

or use the button in the RFEM toolbar shown on the left. 

A window opens, graphically showing the distribution of the maximum design values on the 
member or set of members. 

 
Figure 5.5: Dialog box Result Diagram on Member 

Use the list in the toolbar above to select the relevant RF-TIMBER AWC design case. 

This dialog box Result Diagram on Member is described in the RFEM manual, Chapter 9.5. 
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5.3 Filter for Results 
The RF-TIMBER AWC results windows allow you to sort the results by various criteria. In addition, 
you can use the filter options for graphical evaluation of the results as described in Chapter 9.9 
of the RFEM manual. 

You can use the Visibility option also for RF-TIMBER AWC (see RFEM manual, Chapter 9.9.1) to 
filter the members in order to evaluate them. 

Filtering designs 
The design ratios can easily be used as filter criteria in the RFEM work window which you can 
open by clicking [Graphics]. To apply this filter function, the panel must be displayed. If it is not, 
select 

View → Control Panel (Color scale, Factors, Filter) 

or use the toolbar button shown on the left. 

The panel is described in the RFEM manual, Chapter 3.4.6. The filter settings for the results 
must be defined in the first panel tab (Color spectrum). As this register is not available for the 
two-colored results display, you have to use the Display navigator and set the display options 
Colored With/Without Diagram or Cross-Sections first. 

 
Figure 5.6: Filtering design ratios with adjusted color spectrum 

As the figure above shows, the color spectrum can be set in such a way that only ratios higher 
than 0.50 are shown in a color range between blue and red. 

If you select the Display Hidden Result Diagram option in the Display navigator (Results → Mem-
bers), you can display all design ratio diagrams that are not covered by the color spectrum. 
Those diagrams are represented by dotted lines. 
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Filtering members 
In the Filter tab of the control panel, you can specify the numbers of particular members to 
display their results exclusively, that is, filtered. That function is described in detail in the RFEM 
manual, Chapter 9.9.3. 

 

Figure 5.7: Member filter for ratios of diagonals 

Unlike the partial view function (Visibilities), the model is displayed in the graphic completely. 
The figure above shows the ratios in the diagonals of a truss girder. The remaining members 
are displayed in the model but are shown without design ratios. 



6  Printout 

 60 Program RF-TIMBER AWC © 2014 Dlubal Software GmbH 

 

 

 

6.  Printout 
 

6.1 Printout Report 
Similar to RFEM, the program generates a printout report for the RF-TIMBER AWC results, to 
which you can add graphics and descriptions. The selection in the printout report determines 
what data from the design module will be included in the printout. 

The printout report is described in the RFEM manual. In particular, Chapter 10.1.3.4 Selecting 
Data of Add-on Modules describes how to select input and output data from add-on modules 
for the printout report. 

For complex models with many design cases, it is recommended to split the data into several 
printout reports, thus allowing for a clearly-arranged printout. 

6.2 Graphic Printout 
In RFEM, you can add every picture that is displayed in the work window to the printout report 
or send it directly to a printer. In this way, you can prepare the design ratios displayed on the 
RFEM model for the printout, too. 

Printing of graphics is described in the RFEM manual, Chapter 10.2. 

Designs in the RFEM model 
To print the currently displayed design ratios, click 

File → Print Graphic 

or use the toolbar button shown on the left. 

 
Figure 6.1: Button Print in RFEM toolbar 

Result diagrams 
You can also transfer the Result Diagram on Member to the report or print it directly by using 
the [Print] button. 

 
Figure 6.2: Button Print in the Result Diagram on Member 

The Graphic Printout dialog box appears (see figure on next page). 
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Figure 6.3: Dialog box Graphic Printout, tab General 

This dialog box is described in the RFEM manual, Chapter 10.2. The RFEM manual also describes 
the Options and Color Spectrum tab. 

You can move a graphic anywhere within the printout report by using the drag-and-drop 
function. 

To adjust a graphic subsequently in the printout report, right-click the relevant entry in the 
navigator of the printout report. The Properties option in the context menu opens the Graphic 
Printout dialog box, offering various options for adjustment. 

 
Figure 6.4: Dialog box Graphic Printout, tab Options 
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7.  General Functions 
This chapter describes useful menu functions as well as export options for the designs. 

7.1 Design Cases 
Design cases allow you to group members for the designs: In this way, you can combine 
groups of structural components or analyze members with particular design specifications  
(for example changed materials, partial safety factors, optimization).  

It is no problem to analyze the same member or set of members in different design cases. 

To calculate a RF-TIMBER AWC design case, you can also use the load case list in the RFEM 
toolbar. 

Create new design case 
To create a new design case, use the RF- TIMBER AWC menu and click 

File → New Case. 

The following dialog box appears: 

 
Figure 7.1: Dialog box New RF-TIMBER AWC-Case 

In this dialog box, enter a No. (one that is still available) for the new design case. The corre-
sponding Description will make the selection in the load case list easier. 

Click [OK] to open the RF-TIMBER AWC window 1.1 General Data where you can enter the 
design data. 

Rename design case 
To change the description of a design case, use the RF-TIMBER AWC menu and click 

File → Rename Case. 

The following dialog box appears: 

 
Figure 7.2: Dialog box Rename RF-TIMBER AWC-Case 

In this dialog box, you can specify a different Description as well as a different No. for the 
design case. 
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Copy design case 
To copy the input data of the current design case, use the RF-TIMBER AWC menu 

File → Copy Case 

The following dialog box appears: 

 
Figure 7.3: Dialog box Copy RF-TIMBER AWC-Case 

Define the No. and, if necessary, a Description for the new case. 

Delete design case 
To delete design cases, use the RF-TIMBER AWC menu 

File → Delete Case 

The following dialog box appears: 

 
Figure 7.4: Dialog box Delete Cases 

The design case can be selected in the list Available Cases. To delete the selected case,  
click [OK]. 
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7.2 Cross-Section Optimization 
The design module offers you the option to optimize overloaded or little utilized cross-sections. 
To do this, select in the column D or E of the relevant cross-sections in the 1.3 Cross-Section win-
dow the option Yes (for parametric rectangular or circular sections) or From current row (for 
standardized sections, see Figure 2.19, page 20). 

You can also start the cross-section optimization in the results windows by using the context 
menu. 

 
Figure 7.5: Context-menu for cross-section optimization 

During the optimization process, the module determines the cross-section that fulfills the anal-
ysis requirements in the most optimal way, that is, comes as close as possible to the maximum 
allowable design ratio specified in the Details dialog box (see Figure 3.5, page 42). The required 
cross-section properties are determined with the internal forces from RFEM. If another cross-
section proves to be more favorable, this cross-section is used for the design. Then, the graphic 
in Window 1.3 shows two cross-sections: the original cross-section from RFEM and the opti-
mized one (see Figure 7.7). 

For a parameterized cross-section, the following dialog box appears when you have selected 
Yes from the drop-down list. 

 
Figure 7.6: Dialog box Timber Cross-Sections - Rectangle : Optimize 

By selecting the check boxes in the Optimize column, you decide which parameter(s) you want 
to modify. This enables the Minimum and Maximum columns, where you can specify the upper 
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and lower limits of the parameter. The Increment column determines the interval in which the 
size of the parameter varies during the optimization process. 

If you want to Keep current side proportions, select the corresponding check box. In addition, 
you must select at least two parameters for optimization. 

Please note that the internal forces are not automatically recalculated with the changed cross-
sections during the optimization: It is up to you to decide which cross-sections should be 
transferred to RFEM for recalculation. As a result of optimized cross-sections, internal forces 
may vary considerably because of the changed stiffnesses in the structural system. Therefore, it 
is recommended to recalculate the internal forces of the modified cross-section data after the 
first optimization, and then to optimize the cross-sections once again. 

You can export the modified cross-sections to RFEM: Go to the 1.3 Cross-Sections window, and 
then click 

Edit → Export All Cross-Sections to RFEM 

The context menu available in Window 1.3 also provides options to export optimized cross-
sections to RFEM. 

 
Figure 7.7: Context menu in Window 1.3 Cross-Sections 

Before the changed materials are transferred to RFEM, a security query appears as to whether 
the RFEM results should be deleted.  

 
Figure 7.8: Query before transfer of modified cross-sections to RFEM 

By confirming the query, and then starting the [Calculation] in the RF-TIMBER AWC module, 
the RFEM internal forces as well as the designs will be determined in one single calculation 
run. 

 



7  General Functions 

 66 Program RF-TIMBER AWC © 2014 Dlubal Software GmbH 

 

If the changed cross-sections have not been exported to RFEM yet, you can reimport the origi-
nal cross-sections in the design module by using the options shown in Figure 7.7. Please note 
that this option is only available in the 1.3 Cross-Sections window. 

7.3 Units and Decimal Places 
Units and decimal places for RFEM and the add-on modules are managed in one dialog box.  
To define the units in RF-TIMBER AWC, select menu 

Settings → Units and Decimal Places. 

The following dialog box appears that is familiar from RFEM. RF- TIMBER AWC is preset in the 
Program / Module list. 

 
Figure 7.9: Dialog box Units and Decimal Places 

You can save the settings as a user profile to reuse them in other models. These functions are 
described in the RFEM manual, Chapter 11.1.3.     
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7.4 Data Transfer 
7.4.1 Material Export to RFEM 
If you have modified the materials in RF-TIMBER AWC for design, you can export the modified 
materials to RFEM in a similar way as you export cross-sections: Open the 1.2 Materials win-
dow, and then click  

Edit → Export All Materials to RFEM. 

You can also export the modified materials to RFEM using the context menu of Window 1.2. 

 
Figure 7.10: Context menu of window 1.2 Materials 

Before the changed materials are transferred to RFEM, a security query appears as to whether 
the results of RFEM should be deleted. When you have confirmed the query and then start the 
[Calculation] in RF-TIMBER AWC, the RFEM internal forces and designs are determined in one 
single calculation run. 

If the modified materials have not been exported to RFEM yet, you can transfer the original 
materials to the design module, using the options shown in Figure 7.10. Please note, however, 
that this option is only available in the 1.2 Materials window. 

7.4.2 Export of Effective Length to RFEM 
If you have adjusted the materials in RF-TIMBER AWC for design, you can export the modified 
materials to RFEM in a similar way as you export cross-sections: Open the 1.7 Effective Lengths - 
Members window, and then select 

Edit → Export All Effective Lengths to RFEM 

or use the corresponding option on the context menu of Window 1.7. 

 
Figure 7.11: Context menu of window 1.7 Effective Lengths - Members 

Before the modified materials are transferred to RFEM, a security query appears as to whether 
the results of RFEM should be deleted. 

If the modified effective lengths have not been exported to RFEM yet, you can reimport the 
original effective lengths to the design module by using the options shown in Figure 7.11. 
Please note, however, that this option is only available in the windows 1.7 Effective Lengths - 
Members and 1.8 Effective Lengths - Sets of Members. 

7.4.3 Export of Results 

The RF-TIMBER AWC results can also be used by other programs. 

Clipboard 
To copy selected cells of the results windows to the Clipboard, use the [Ctrl]+[C] keys. To insert 
the cells, for example in a word processing program, press [Ctrl]+[V]. The headers of the table 
columns will not be transferred. 
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Printout Report 
You can print the data of the RF-TIMBER AWC add-on module into the global printout report 
(see Chapter 6.1, page 60) for export. Then, in the printout report, click 

File → Export to RTF 

The function is described in the RFEM manual, Chapter 10.1.11. 

Excel / OpenOffice 
RF-TIMBER AWC provides a function for the direct data export to MS Excel, OpenOffice.org Calc, 
or the file format CSV. To open the corresponding dialog box, click 

File → Export Tables 

The following export dialog box appears. 

 
Figure 7.12: Dialog box Export - MS Excel 

When you have selected the relevant options, you can start the export by clicking [OK].  
Excel or OpenOffice will be started automatically, that is, the programs do not have to be 
opened first. 

 
Figure 7.13: Results in Excel 
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8.  Examples 
 

8.1 Beam Column (LRFD Solution) 
We perform the design according to ANSI/AWC NDS-2012 for a wood column that is restrained 
and subjected to compression and bending. It is embedded at the base providing approximate 
fixity, and it is free to undergo sidesway about the strong axis of bending at the top. There are 
wet ground conditions. Lateral bracing about the weak direction of bending is provided every  
4 ft by wall girts. In case of major axis bending, the concentrated force at the top represents the 
spring force resulting from the approximate stiffness imparted by the building on a representa-
tive post.  

The example is described in [4]. 

8.1.1 System and Loads 
 

Model 

Cross-section:  Nominal 4 in by 12 in 

(Standard Dressed 3-1/2 in 
by 11-1/4 in) 

Material: Southern Pine, No. 1 Dense 

Moisture Condition:  Wet 

Temperature Condition: T ≤ 100°F 

 

Load 

Load Combination:  1.2D + 1.6S + 0.8W 

LC 1 Dead:  500 lbf 

LC 2 Snow: 4200 lbf 

LC 3 Wind: 160 lbf/ft and 300 lbf 

 

Figure 8.1: System and loads according to [4] 

8.1.2 Calculation with RFEM 
The system as well as the loads in all load cases is modeled in RFEM as a 3D model. We deacti-
vate the automatic consideration of the self-weight when we create LC1. 

We create the considered load combination with relevant factors from defined load cases. 
Then we calculate the model according to the linear static analysis. 
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RFEM determines the diagrams of internal forces shown in the following figure. 

 
Figure 8.2: Internal forces N, My, and Vz 

8.1.3 Design with RF-TIMBER AWC 
In Window 1.1 General Data, we select the result combination CO1 for the Ultimate Limit State 
design. 

We perform the design according to LRFD. 

 
Figure 8.3: Window 1.1 General Data 
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The 1.2 Materials window presents the characteristic strengths of the selected material. 

 
Figure 8.4: Window 1.2 Materials 

In the 1.3 Cross-Sections window, the parameters of the cross-section can be checked.  

 
Figure 8.5: Window 1.3 Cross-Sections 
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In Window 1.4 Load Duration, we define the load duration. For LRFD it is recommended to as-
sign a user-defined load duration also for a load combination because the choice according 
to shortest load duration in a combination does not always reflect the appropriate value of 
time effect factor λ according to Table N3 of [1].  

 
Figure 8.6: Window 1.4 Load Duration 

In Window 1.6 In-Service Conditions - Set of Members, we define the moisture and temperature 
conditions. The factors CM and CT are determined as for wet service conditions and sustained 
exposure to elevated temperatures up to 100°F. 

 
Figure 8.7: Window 1.6 In-Service Conditions - Set of Members 
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In the 1.8 Effective Lengths - Sets of Members window we specify the buckling lengths of the 
column. The recommended value of buckling length coefficient Kex = 2.1 is taken for the major 
axis stability calculation. 

For the minor axis stability calculation we define directly the buckling length ley = 4 ft as the 
length between lateral bracing girts multiplied by a factor of 1.0. The effective length for lat-
eral buckling is calculated as unbraced length 4 ft associated with major axis bending multi-
plied by factor 2.06, this equation is defined in footnote 1 in Table 3.3.3 in [1]. 

 
Figure 8.8: Window 1.8 Effective Lengths – Set of Members 

In Window 1.9 Additional Design Parameters, the use of further adjustment factors is not re-
quired. No member is incised according to 4.3.8 or acts as repetitive according to 4.3.9 in [1] . 

 
Figure 8.9: Window 1.9 Additional Design Parameters 

We start the calculation by clicking the [Calculation] button. 
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After the calculation, the governing design is presented in the 2.1 Design by Load Case window. 

 
Figure 8.10: Window 2.1 Design by Load Case 

The Details displayed in the lower part of the window correspond to the designs in [4]. 

The column capacities, which are modified by adjustment factors, are calculated without con-
sideration of stability factors. This calculation is done before the calculation of the design ratio. 
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The stress analysis is performed as follows. 
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The compressive design stress must be adjusted also by the column stability factor CP. This factor 
depends on the critical buckling stress for compression which reflects the member slenderness 
of compression members. 

The total axial capacity for the major axis is calculated as follows. 
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Adjusted Compressive Design Value Parallel to Grain 
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The total axial capacity for the minor axis is calculated in the same way. 

Slenderness Ratio 
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Adjusted Compressive Design Value Parallel to Grain 
 

psi27.1955832.008.2350C*F'F pyccy =×=×=  

The bending design stress must also be adjusted by the beam stability factor CL. This factor 
depends on the critical buckling stress for bending which reflects the member slenderness  
of bending members. 

The total flexural capacity is calculated as follows. 
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Critical Buckling Design Value for Bending Members 
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Adjusted Bending Design Value: 
 

psi18.2156989.016.2180C*F'F Lbbx =×=×=  
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Critical Design Values Check 
Before combined bending and axial compression proportions are verified, critical design 
stresses must be compared according to Equation (3.9-4) and the next formulas mentioned in 
[1], Clause 3.9.2. 
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Combined Bending and Axial Compression Design 

Design of combined bending and axial compression according to [1], Equation (3.9-3): 

Design 1 (buckling about x-x axis) 
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Design 2 (buckling about y-y axis) 
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Shear Design 

The shear design is performed according to [1], Clause 3.4.1: 

Design 
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v
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8.2 Glued Laminated Beam (ASD Solution) 
We perform the design according to ANSI/AWC NDS-2012 for a structural glued laminated roof 
purlin that is restrained and subjected to biaxial bending. The beam is laterally supported at its 
ends only, and there are no intermediate lateral supports. 

The example is described in [4]. 

8.2.1 System and Loads 

 

Figure 8.11: System and loads according to [4] 

Model  Loads  

Cross-section:  6-3/4 in by 24 in Load Combination:  D + Lr 

Material:  Douglas-fir 24F-V10 LC 1 Deadx: 264 lbf/ft 

Moisture Condition:  Dry LC 1 Deady: 14 lbf/ft 

Temperature Condition:  T ≤ 100°F LC 2 Roof Livex: 1053 lbf/ft 

  LC 2 Roof Livey: 52 lbf/ft 

8.2.2 Calculation with RFEM 
The system as well as the loads in all load cases is modeled in RFEM as a 3D model. We deacti-
vate the automatic consideration of the self-weight when we create LC1. 

We create the considered load combination with relevant factors from defined load cases. 
Then we calculate the model according to the linear static analysis. 
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RFEM determines the diagrams of internal forces shown in the following figure. 

 
Figure 8.12: Internal forces My, MZ, VZ, and Vy 
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8.2.3 Design with RF-TIMBER AWC 
8.2.3.1 Ultimate Limit State Design 

In Window 1.1 General Data, we select the result combination CO1 for the Ultimate Limit State 
design. 

We perform the design according to ASD. 

 
Figure 8.13: Window 1.1 General Data 

The 1.2 Materials window presents the characteristic strengths of the selected material. 

 
Figure 8.14: Window 1.2 Materials 
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In the 1.3 Cross-Sections window, the parameters of the cross-section can be checked. 

 
Figure 8.15: Window 1.3 Cross-Sections 

In Window 1.4 Load Duration, we define the load duration. For ASD, the load duration for load 
combination is assigned according to the shortest load duration included in this combination. 
The load duration of CO1 is preset as Seven Days. 

 
Figure 8.16: Window 1.4 Load Duration 
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In Window 1.5 In-Service Condition - Members, we define the moisture and temperature condi-
tions. The factors CM and CT are determined for dry service conditions and sustained exposure 
to elevated temperatures up to 100°F. 

 
Figure 8.17: Window 1.5 In-Service Conditions - Members 

In Window 1.7 Effective Lengths - Members we specify the buckling lengths. The beam is braced 
only at the ends. The effective buckling length for lateral-torsional buckling is automatically 
calculated according to [1] Table 3.3.3 for a single spam beam with uniformly distributed load 
where ratio of the unbraced length and the depth of the cross-section is higher than seven: 

le = 1.63 x unbraced length + 3 x depth of cross-section = 45.12 ft. 

 
Figure 8.18: Window 1.7 Effective Lengths - Members 
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In Window 1.9 Additional Design Parameters, the use of further adjustment factors is not re-
quired. There is no shear reduction to be applied. 

 
Figure 8.19: Window 1.9 Additional Design Parameters 

We start the calculation by clicking the [Calculation] button. 

After the calculation, the governing design is presented in the 2.1 Design by Load Case window. 

 
Figure 8.20: Window 2.1 Design by Load Case 
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The Details displayed in the lower part of the window correspond to the designs in [4]. 

The beam capacities, which are modified by adjustment factors, are calculated without consid-
eration of stability factors. This calculation is done before the calculation of the design ratio.  

Partially Adjusted Bending Design Values 

psi00.3000*F

25.10.10.12400*F

CCCF*F

bx

bx

DtMbxbx

=
×××=
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Adjusted Modulus of Elasticity for Stability Calculations 
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Adjusted Shear Design Values 
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The stress analysis is performed as follows. 
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The bending design stress must be adjusted also by the lesser of the beam stability factor, CL, 
and volume factor, CV.  

The beam stability factor depends on the critical buckling stress for bending which reflects the 
member slenderness of bending members. 
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Slenderness Ratio 
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Critical Buckling Design Value for Bending Members 
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The volume factor depends on the cross-section dimensions [in] and the length of the bending 
member between points of zero moment [ft]. 
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The total flexural capacity is calculated as follows. 

Adjusted Bending Design Values: 

( ) ( ) psi00.2565896.0;855.0min00.3000C;Cmin(F'F VLbxbx =×=×=  

psi38.193907.150.1812C*F'F fubyby =×=×=  

Critical Design Values Check 
Before biaxial bending proportions are verified, critical design stresses must be compared ac-
cording to formulas mentioned in [1] (Chapter 3.9.2). 
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Biaxial Bending Design 
The design of biaxial bending according to [1], Equation (3.9-3) is as follows: 
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Shear Design 
The design of shear is performed according to [1], Clause 3.4.1: 

Design 1 (Shear due to shear force Vx) 
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vx ≤==  

Design 2 (Shear due to shear force Vy) 
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f
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8.2.3.2 Serviceability Limit State Design 

We check the deflection limit for the unfactored live load.  

In the Serviceability Limit State tab of the 1.1 General Data window, we select the load case 
LC2 Live for the design. 

 
Figure 8.21: Window 1.1 General Data, tab Serviceability Limit State 

Then we enter member No. 1 in the 1.10 Serviceability Data window 

 
Figure 8.22: Window 1.10 Serviceability Data 

We do not modify the reference length but we restrict the Direction to y. As a simple span 
beam, we select the Beam in the Beam Type list. 
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In the dialog box Details, tab Serviceability, we change one setting: The deformation is to be 
relative to the Undeformed system. 

 
Figure 8.23: Dialog box Details, tab Serviceability 

The limiting deflection is L/360 according to Table 1604.3 in [6]. 

For the following equation, the modulus of elasticity of 1800000 psi is applied. 
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The result of this deformation analysis is also displayed in the 2.1 Design by Load Case result 
window under the table entry Serviceability Limit State Design. 

 
Figure 8.24: Window 2.1 Design by Load Case 
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8.3 Single Tapered Beam 
According to the Design Specification [1], the strength of a tapered beam must be reduced 
depending on the loading (tensile bending or compressive bending). This usually applies to 
single tapered beams. 

The single tapered beam of the following example is laterally supported over its entire length. 

8.3.1 System and Loads 

 
Figure 8.25: System and loads 

Model 

Material:  Southern Pine 24F-V5 

Length: 40 ft 

Cross-section 1:  5-1/2 in by 22 in (start) 

Cross-section 2:  5-1/2 in by 49-1/2 in (end) 

Moisture Condition:  Dry 

Temperature Condition:  T ≤ 100°F 

Loads  

Load Combination:  D + S 

LC 1 Dead: Self-weight and 300 lbf/ft 

LC 2 Snow: 300 lbf/ft 

8.3.2 Calculation with RFEM 
The system as well as the loads in all load cases is modeled in RFEM as a 3D model. We make 
sure that the automatic self-weight is activated in LC1. 

We create the considered load combination with relevant factors from the defined load cases. 
Then we calculate the model according to the linear static analysis. 

RFEM determines the diagrams of internal forces shown in the following figure. 
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Figure 8.26: Internal forces My and Vz 

8.3.3 Design with RF-TIMBER AWC 

Ultimate Limit State Design 
In Window 1.1 General Data, we select the result combination CO1 for the Ultimate Limit State 
design. 

We perform the design according to ASD. 

 
Figure 8.27: Window 1.1 General Data 
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The 1.2 Materials window presents the characteristic strengths of the selected material. 

 
Figure 8.28: Window 1.2 Materials 

In the 1.3 Cross-Sections window, the parameters of the two cross-sections can be checked. 

 
Figure 8.29: Window 1.3 Cross-Sections 
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In Window 1.4 Load Duration, we define the load duration. For ASD, the load duration for load 
combination is assigned according to the shortest load duration included in this combination. 
The load duration of CO1 is preset as Two Months. 

As the beam is not loaded by any wind or earthquake load, the load condition for radial stress 
design according to [1] Table 5.2.8 is set as Other Types of Loading. 

 
Figure 8.30: Window 1.4 Load Duration 

In Window 1.5 In-Service Condition - Members, we define the moisture and temperature condi-
tions. The factors CM and CT are determined for dry service conditions and sustained exposure 
to elevated temperatures up to 100°F. 

 
Figure 8.31: Window 1.5 In-Service Conditions - Members 
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In Window 1.7 Effective Lengths - Members we specify the buckling lengths. The beam is lateral-
ly supported over its entire length continuously. Therefore, there is no risk of instability. We 
clear the two check boxes Buckling Possible and Lateral-Torsional Buckling. 

 
Figure 8.32: Window 1.7 Effective Lengths - Members 

In Window 1.9 Additional Design Properties, the use of further adjustment factors is not re-
quired. There is no shear reduction to be applied. 

 
Figure 8.33: Window 1.9 Additional Design Parameters 
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The tapered member is automatically listed in Window 1.14 Tapered Members, including the 
preset angle of taper which is 3.28°. 

 
Figure 8.34: Window 1.14 Tapered Members 

The grain runs parallel to the edge which is located in the direction of the positive z/y-axis 
(this is the bottom side of the member). Thus, the cut face of the beam is in the compressive 
bending area (it would also be possible to design taper cuts on the tension face, but those cuts 
are not recommended for structural glued laminated timber beams). 

We then start the calculation by clicking the [Calculation] button. 

After the calculation, the governing design is presented in the 2.1 Design by Load Case window. 

 
Figure 8.35: Window 2.1 Design by Load Case 
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The beam capacities, which are modified by adjustment factors, are calculated as follows: 

Partially Adjusted Bending Design Value 
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The stress analysis is performed as follows. 
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The bending design stress must be adjusted also by the lesser of the stress interaction factor, CI, 
and volume factor, CV. 

The stress interaction factor depends on the face of taper. For members tapered on the com-
pression side, this factor is calculated as follows. 
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The volume factor depends on the cross-section dimensions at the verified point on the beam 
(dimensions and length of bending member between points of zero moment in ft). 
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With this factor, the total flexural capacity can be calculated as follows. 

Adjusted Bending Design Values 

( ) ( ) psi44.2329921.0;844.0min00.2760C;Cmin(F'F VIbxbx =×=×=  

Bending Design 

Design of bending according to [1] Chapter 3.3.1: 
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Shear Design 
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8.4 Curved Beam (LRFD Solution) 
According to the Design Specification [1], the cross-section resistance design can be also per-
formed for curved sections of bending members. The cross-section must be constant in those 
parts. In RF-TIMBER AWC, members of that type are not allowed for stability calculations, how-
ever. 

8.4.1 System and Loads 

 
Figure 8.36: System and loads 

Model   

Material:   Douglas Fir-Larch 16F-V3 

Length:  66 ft 

Radius of Curvature at Centerline: 50 ft 

Cross-section:   8-3/4 in by 51 in 

Thickness of Lamination  1-1/2 in 

Moisture Condition:   Dry 

Temperature Condition:   T ≤ 100°F 

Loads  

Load Combination:   1.2D + 1.6S 

LC 1 Dead:  85 lbf/ft 

LC 2 Snow:  350 lbf/ft 

8.4.2 Calculation with RFEM 
The system as well as the loads in all load cases is modeled in RFEM as a 3D model. We deacti-
vate the automatic consideration of the self-weight when we create LC1. 

We create the considered load combination with relevant factors from the defined load cases. 
Then we calculate the model according to the linear static analysis. 

RFEM determines the diagrams of internal forces shown in the following figure. 
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Figure 8.37: Internal forces N, My and Vz 

8.4.3 Design with RF-TIMBER AWC 
Ultimate Limit State Design 
In Window 1.1 General Data, we select the result combination CO1 for the Ultimate Limit State 
design. We perform the design according to LRFD. 

 
Figure 8.38: Window 1.1 General Data 
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The 1.2 Materials window presents the characteristic strengths of the selected material. 

 
Figure 8.39: Window 1.2 Materials 

In the 1.3 Cross-Sections window, the parameters of the glulam section can be checked. 

 
Figure 8.40: Window 1.3 Cross-Sections 
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In Window 1.4 Load Duration, we define the load duration. For LRFD, User-defined settings 
are recommended for load combinations because the choice according to the shortest load 
duration within a combination does not always reflect the appropriate value of the time effect 
factor λ according to [1] Table N3. 

As the beam is not loaded by any wind or earthquake load, the load condition for radial stress 
design according to Table 5.2.8 in [1] is set as Other Types of Loading. 

 
Figure 8.41: Window 1.4 Load Duration 

In window 1.6 In-Service Condition - Set of Members, we define the moisture and temperature 
conditions. The factors CM and CT are determined as for dry service conditions and sustained 
exposure to elevated temperatures up to 100°F. 

 
Figure 8.42: Window 1.6 In-Service Conditions - Set of Members 
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Since the beam is laterally supported, we deactivate the stability analysis in the Details  
dialog box. 

 
Figure 8.43: Dialog box Details, tab Stability 

In Window 1.9 Additional Design Properties, the use of further adjustment factors is not re-
quired. There is no shear reduction to be applied. 

 
Figure 8.44: Window 1.9 Additional Design Parameters 
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Window 1.11 Curved Members controls the input of the curved sections. 

 
Figure 8.45: Window 1.11 Curved Members 

The thickness of the lamellas is set as 1.5 in. This value is directly reflected in the check of the 
minimum radius of curvature (inside face of curved member). 

We tick the check box in the Radial Stress Design column so that RF-TIMBER AWC performs a 
check of the radial stresses. 

Then we start the calculation by clicking the [Calculation] button. 

After the calculation, the governing design ratios are shown in the 2.3 Design by Set of Members 
window. 

 
Figure 8.46: Window 2.3 Design by Set on Members 
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The capacities of the curved member, which are modified by adjustment factors, are calculated 
as follows: 

Curvature Factor 

( )
( )
psi986373.0C

56.574/5.120001C

R/t20001C

c

2
c

2
c

=
×/=

×/=

  

Partially Adjusted Bending Design Value 

psi86.2725*F

0.10.1986373.0160085.054.28.0*F

CCCFK*F

bx

bx

tMcbxFbx

=
××××××=

××××Φ××λ=
 

Adjusted Shear Design Values 

psi92.457'F

8.075.088.20.10.1265'F

KCCF'F

vx

vx

FtMvxvx

=
×××××=

λ×Φ××××=
 

Adjusted Radial Tension Stress 

psi92.25'F

8.075.088.20.10.115'F

CCF'F

rt

rt

tMrtrt

=
×××××=

λ×Φ×××=
 

The stress analysis is performed as follows. 

Actual Bending Stresses 

psi76.1143
in1.3793

ft.lbf361534
S
M

f
3

x

x
bx ===  

Actual Shear Stress Parallel to Grain 

psi21.71
in75.8in07.96724

in84.2844lbf21186

bI

QV
f

4

3

x

xx
vx =

×

×
=

×
×

=   

Actual Radial Stress 

psi30.24
0.5175.80.502

ft.lbf3615343

dbR2

M3
f x
r =

×××
×

=
×××

×
=  

The bending design stress must be adjusted also by the volume factor, CV.  This factor depends 
on the cross-section dimensions at the verified point on the beam (dimensions and length of 
bending member between points of zero moment in ft.). 

Volume Factor 

7296.0C

)
75.8

125.5
()

0.51

12
()

72.67

21
(C

)
b

125.5
()

d

12
()

L

21
(C

V

10/110/110/1
V

x/1x/1x/1
V

=

××=

××=
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With this factor, the total flexural capacity can be calculated as follows. 

Adjusted Bending Design Values 

psi79.19887296.086.2725C*F'F Vbxbx =×=×=  

Bending Design 

Design of bending according to [1] Chapter 3.3.1: 

Design 

00.1
79.1988

76.1143

'F

f

bx

bx ≤0078==  

Shear Design 
Design of shear according to [1] Chapter 3.4.1: 

Design  

00.116.0
92.457

21.71

'F

f

vx

vx ≤==  

Radial Tension Design 
Design of radial stress according to [1] Chapter 5.4.1.3: 

Design  

00.194.0
92.25

30.24

'F

f

rt

r ≤==  
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